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1. Introduction 
 

1.1 About StealthMail 
StealthMail is committed to developing solutions that secure sensitive business 
correspondence. The StealthMail team has over 13 years of experience in developing 
secure solutions in both governmental and military sectors. 

 

1.2 What is an Outlook Add-in 
Outlook Add-in is a software extension that can be embedded in the Microsoft 
Outlook desktop application and extend its capabilities with additional features.  

Once an Add-in is installed, additional buttons, tabs and bars may appear on the 
Outlook’s Ribbon. 

 

1.3 About StealthMail Add-in 
StealthMail Add-in is an add-in for Microsoft Outlook that ensures privacy and 
provides security for business email correspondence.  

The solution eliminates the need to transfer email contents and attachments over 
public communication channels which are traditionally used to deliver email. Instead, 
the service separately encrypts the contents and attachments which are then 
transferred over secure encrypted communication channels.  

 

2. General information  
 

2.1 About this guide 
This guide contains step-by-step guidelines on how to install StealthMail Add-in, add 
an account, configure different service parameters, troubleshoot problems, etc. This 
guide also provides detailed information on how to create, send, and view secure 
emails sent via the StealthMail Add-in service for Outlook. 
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2.3 User support 
If you have any questions connected with the work of the service, contact the 
administrator of your company. In case, the issue cannot be resolved by the means 
of the company’s administrator, redirect the issue to the StealthMail Service Support 
Portal. 

 

2.4 Additional resources  
For additional reference, you can use the Video Help section on the StealthMail 
website. The resource contains video tutorials which demonstrate the main features 
of the StealthMail Add-in and explain how to use them.  

 

3. Installation 
Before installing, StealthMail Add-in installation package should be provided by the 
administrator of the company.  

Important: Close Microsoft Outlook before you proceed with the installation of StealthMail Add-in.  

Follow these steps to install StealthMail Add-in: 

1. Open the folder that contains the installation package. 

2. Select and run stealthmail_add-in_1.3.x.x.exe (Fig. 3-1). 

 
Figure 3-1 StealthMail Add-in installation package 
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3. In the User Account Control window, click Yes (Fig. 3-2). 

 
Figure 3-2 Security window 

4. From the drop-down menu, choose preferred Setup Language and click OK  
(Fig. 3-3). 

 
Figure 3-3 Select Setup Language 

5. Read the terms of the End User License Agreement carefully. Select I accept the 
agreement, and then click Next to continue the installation (Fig. 3-4). 
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Figure 3-4 The terms of the License Agreement window  

6. Wait until the Setup Wizard completes the installation of the StealthMail Add-in on 
your computer. 

7. Click Finish to close the installation window (Fig. 3-5). 

8. After successfully installing the application, open Microsoft Outlook to start 
using the service. 
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Figure 3-5 StealthMail Add-in installation window 

3.1 Interface  
After installing the service, you will see the following StealthMail Add-in interface in 
Microsoft Outlook: 

- The StealthMail tab will appear on the Outlook Ribbon (Fig. 3.1-1); 

  
 Figure 3.1-1 StealthMail tab 

- On the Home tab, the Settings bar will be displayed (Fig.3.1-2); 

 

Figure 3.1-2 StealthMail Settings pane 
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- The StealthMail bar will be displayed on the Message tab. The bar is used to 
switch between security modes (Fig.3.1-3). 

 
Figure 3.1-3 StealthMail bar 

Note: For more information about the commands, please refer to the StealthMail tab chapter. 
For more information about the settings, please refer to the Settings chapter. 

When sending an email to external contacts (people who work outside the 
organization), their phone number needs to be specified in the External Users 
section of the StealthMail Add-In sidebar. 

Note: For more information on how to send an email to the external users, please refer to the 
Sending a secure email to external recipients chapter. 

Click  to Hide/Show the StealthMail bar (Fig. 3.1-4). 
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Figure 3.1-4 Hide/Show StealthMail bar 

 

4. Getting started 
This chapter provides basic instructions on how to use the StealthMail add-in. 

 

4.1 Adding StealthMail account 
Before you start using StealthMail Add-in service, you need to add a StealthMail 
account. StealthMail account allows you to create and send encrypted emails, and 
manage permissions (Deny Reply, Forward and Copy of the email content). 

To add a StealthMail account, you need to know a domain address of your company 
that is used for the StealthMail service. Usually, it is similar to a domain that goes 
after the @ symbol in your corporate email address (e.g., name@domain.com).  

 

You can add an account in one of two ways: 

1. From the Accounts sidebar.  

2. In the email preview window. 

 

4.1.1 Adding an account from the Accounts sidebar 

Before you add an account, get the domain name of your company from the 

administrator. 
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To add an account:  

1. On the Ribbon, select the StealthMail tab, and click Accounts . 

2. In the opened Accounts sidebar, click the Add account button (Fig. 4.1.1).  

3. To complete authorization, follow steps 3 through 6 of the Adding an account 

from the email preview window chapter. 

 
Figure 4.1.1 Accounts sidebar 

Note: If you’re having any problems while adding an account, please point to the  
Troubleshooting chapter, or contact your system administrator.  

 

4.1.2 Adding an account from the email preview window 

This method requires you to have a secure email in your Inbox folder, sent with 
StealthMail Outlook Add-in or any other StealthMail client. The email comprises the 
following text: This email was encrypted by StealthMail Add-In [version] (Fig. 4.1.2-1).  

 
Figure 4.1.2-1 Notification about the need of authorization 
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Note: To watch a video about the process of email decryption, as well as download the 
StealthMail Add-in for Outlook, click the Open Secure Email button. 

 

To add an account: 

1. Open a secure email. 

2. In the secure email preview window, click the Authorize button (Fig. 4.1.2-2).  

 

 
Figure 4.1.2-2 Adding an account in the email preview window 

3. In the new dialog window, select the account and specify the domain name of 
the company, and then click Next (Fig. 4.1.2-3).  

The service will send an SMS with a verification code to your phone number 
(your phone number should be already added in StealthMail profile by 
company administrator). 

 
 Figure 4.1.2-3 Adding an account 

4. In the code confirmation window, enter the six-digit code from the SMS, and 
then click Next (Fig. 4.1.2-4). 
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Figure 4.1.2-4 Verification code entry  

5. In the password window, enter the password in the Password field, if 
requested, repeat the password in the Confirm Password field, and then click 
Next (Fig. 4.1.2-5). 
 

If you already passed the authorization steps in the past, you just need to enter 
the StealthMail account password. 

 
Figure 4.1.2-5 Password entry 

After a successful account adding, you will be able to view the content of the secure 
email: StealthMail will automatically download and decrypt it. 
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4.2 Authorizing into StealthMail account  

Every time you open Microsoft Outlook, you need to authorize into your StealthMail 
account. This allows you create, send and view encrypted emails. You can authorize 
into your StealthMail Add-in account manually via the Accounts sidebar (Navigate to 
StealthMail tab > Accounts ) or by clicking the Authorize button in the email 
preview window. 

 

4.2.1 Authorizing from the Accounts sidebar  

To authorize into account, perform the 
following steps: 

1. On the Ribbon, on the 
StealthMail tab, click the 

Accounts  icon . 

2. In the Accounts sidebar, in the 
block with your current account 
data, press the Authorize button 
(Fig. 4.2.1-1). 

Figure 4.2.1-1 Accounts sidebar 

3. In the Authorization sidebar, enter the password for your account in the 
Password field, and then click Authorize (Fig. 4.2.1-2).  

 
Figure 4.2.1-2 Password entry 

After a successful account authorization in the Accounts sidebar, your current 
account status will be displayed in the block with your account data (Fig. 4.2.1-5): 
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Figure 4.2.1-3 Accounts sidebar. Account status 

Note: You can also check the account status in the Status section: 
Accounts > Details > Account Details > Status. 

 

If you want to log out of your account: in the Accounts sidebar, in the block with your 
account data, click the Disconnect button. 

 

4.2.2 Authorizing from the email preview window  

You need to be authorized in StealthMail Add-In to preview a secure emails (if you 
haven’t authorized in account earlier). 
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Figure 4.2.2-1 Email preview window 

 

To authorize into an account: 

1. In the email preview window, click the Authorize button (Fig. 4.2.2-1). 

2. In the Authorization sidebar, in the Password field, enter your account 
password, and then click Authorize (Fig. 4.2.2-2). 

 
Figure 4.2.2-2 Authorization sidebar 
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4.3 Creating and sending a secure email  
Secure emails can be created only by employees of the company that use StealthMail 
service. These users are called internal users. Users, who are "outside" of the 
company (without a StealthMail Add-in account), can only reply to secure emails they 
have received. These users are called external users.  

By default, the service creates an email in the Unprotected mode (Fig. 4.3).  

 
Figure 4.3 Creating and sending a secure email 

Note: For more information about secure modes, see the Security options for new emails chapter. 

 

4.3.1 Sending a secure email to internal recipients  

Follow these steps to create and send a secure email to the internal recipients  
(Fig. 4.3.1): 

1. Authorize into your StealthMail account. 

2. On the Home tab, in the New group, select New Email. 

3. Click Secure to switch to secure mode.  

4. Fill out Subject field and specify recipients.  

5. Write an email and add attachments if needed. 

6. Click the Send button.  
StealthMail will encrypt and send your email (Fig. 4.3.1). 
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Figure 4.3.1 Sending a secure email to internal recipients 

Note: For more information on how to add attachments, see Adding attachments chapter.  

 

4.3.2 Sending a secure email to external recipients  

Follow these steps to create and send a secure email to external recipients:  

1. Authorize into your StealthMail account. 

2. On the Home tab, in the New group, select New Email (Fig. 4.3.2-1). 

3. Write an email and add attachments if needed. 

4. If external recipient doesn’t have a StealthMail account yet, in the StealthMail 
Add-in sidebar, in the External Users section, select the country and specify 
the phone number of the external user. 

5. Specify the subject of the message and the email address of the recipient. 

6. Click the Send button.  
StealthMail will encrypt and send your email. 
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Figure 4.3.2-1 Sending a secure email to external recipients 

Note: For more information on how to add attachments, see the Adding attachments chapter. 

 

Caution! When sending an email to an external recipient, the service will prompt 
you to enter the recipient's phone number. The corresponding security alert will be 
displayed in StealthMail bar (Fig. 4.3.2-2). 

 
Figure 4.3.2-2 Security notification 

On the sidebar, in the External Users section, the service will also prompt you to 
specify recipient’s location and phone number (Fig. 4.3.2-3). 
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Figure 4.3.2-3 External Users section 

Note: The phone number is required in order for the recipient to be able to 
authorize and read the contents of the email. 

 

4.4 Viewing contents and attachments of secure emails  

To read the content and view attachments of a secure email, you need to authorize 
into your StealthMail account. 

 
If you haven’t authorized into your account after starting Microsoft Outlook, the 
service will display a corresponding authorization notification in the email preview 
window (Fig. 4.4-1). 

 
Figure 4.4-1 Authorization notification 

To authorize into an account: 

1. Open a secure email; 

2. In the secure email preview window, click the Authorize  button 
(Fig. 4.4-2). 
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Figure 4.4-2 Login notification in the secure email preview window 

3. In the Authorization section, enter your 
account password, and then click Authorize 
(Fig. 4.4-3). 

4. Once you authorize, StealthMail will 
automatically decrypt and display the 
contents of a secure email (Fig. 4.4-4).  

Figure 4.4-3 Authorization sidebar 

 

 
Figure 4.4-4 Secure email preview 
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Note: For information on how to disable automatic preview of secure email upon authorization or 
when new account is added, please refer to the Secure email contents chapter. 

 

4.5 Adding attachments 
This chapter provides instructions on how to add attachments to a new email. 
You can add documents, images, video and audio files to the message.  

To add an attachment, follow these steps:  

1. Authorize into your StealthMail account. 

2. On the Home tab, in the New group, select New Email. 

3. Click Secure to switch to the Secure mode.  

4. On the Message tab, select Attach File. 

5. Select a file you want to attach, and click Insert (Fig. 4.5-1). 

 
Figure 4.5-1 Adding an attachment 

6. Your attached files will be displayed in the StealthMail sidebar in the 
Attachments section (Fig. 4.5-2).  

 
Figure 4.5-2 Attachments section 
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4.6 Checking the status of sent emails 
This chapter contains instructions on how to track statuses of the sent emails. 

You can check the status of any email you send, regardless the email has been sent 
to an external or internal recipient. 

To check the email status of sent messages: 

1. Authorize into your StealthMail account. 

2. Go to the Sent Items folder. 

3. Select an email that you want to check. 

4. Open the StealthMail Add-in sidebar. 

5. Point to the Email Tracking section. 

 
Figure 4.6-1 Email read status 

This section displays whether the sent message or one of its attachments has been 
opened. 

If the recipient has opened the email, the email status will be updated. 

4.7 Recalling of sent emails 
This chapter provides instructions on how to recall an email you have sent. 

You can recall any email you send using StealthMail, regardless of whether it has 
been sent to an external or internal recipient.  

Important: When the email is recalled, all recipients are no longer able to access the content or 
attachments of that email. 
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To recall an email: 

1. Authorize into your StealthMail account. 

2. Go to the Sent Items folder. 

3. Select an email you want to recall. 

4. Open the StealthMail Add-in sidebar. 

5. Point to the Email Recall section. 

6. Click Recall Email. 

7. Click OK to confirm (Fig. 4.7-1) 

 
Figure 4.7-1 Email recall confirmation 

Upon confirmation, the email will no longer be available for preview for all recipients 
(Fig. 4.7-2). 

 
Figure 4.7-2 Email Recall status 
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4.8 Restricting access to emails 

StealthMail Add-In allows you to restrict access rights to the contents of the email 
and its attachments. 

In the current version, you can use these options: 

● Deny Reply  

● Deny Forward  

● Deny Copy and Print 

 

Important: All the limitations you apply onto recipients' emails also apply to you as the sender 
(author) of such emails. 

 

4.8.1 Deny reply 

If you select this restriction, recipients will not be able to perform such actions over 
email’s content: 

● Copy; 

● Take a screenshot; 

● Print; 

● Forward. 

 
Note: It is not possible to add attachments to an email if the Deny Reply option is selected. 

 

To send an email and deny recipients to answer it: 

1. In Outlook, on the Home tab, in the New 
group, click New Email. 

2. Select the Secure mode to switch to email 
encryption mode. 

3. In the Email details sidebar, click Restrictions, 
and then select the Deny Reply option  
(Fig. 4.8.1). 
Make sure, another two options are not 
selected. Figure 4.8.1 Deny Reply restriction 

4. Write and send an email. 
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4.8.2 Deny forward 

If you select this restriction, recipients will not 
have the possibility to send emails to other users. 

To send an e-mail and deny recipients to forward 
it: 

1. In Outlook, on the Home tab, in the New 
group, click New Email. 

2. Select the Secure mode to switch to email 
encryption mode. 

Figure 4.8.2 Deny Forward restriction 

3. In the Email details sidebar, click Restrictions, and then select the  
Deny forward option (Fig. 4.8.2). 
Make sure, another two options are not selected.  

4. Write and send an email. 

 

Tip: Add the Deny Reply restriction to limit the recipient's right to reply to an email. 

 

 

4.8.3 Deny copy and print 

If you select this restriction, recipients will not have the possibility to copy, print, and 
forward emails to other users. However, recipients will have the ability to reply on 
such restricted emails. 

To send an e-mail and deny recipients to copy, 
print, and forward it: 

1. In Outlook, on the Home tab, in the New 
group, click New Email. 

2. Select the Secure mode, to switch to 
email encryption mode. 

3. In the Email details sidebar, click 
Restrictions, and then select the Deny 
Print and Copy option (Fig. 4.8.3). 

4. Write and send an email.  Figure 4.8.3 Deny Copy & Print restriction 

 

Tip: Add the Deny Reply restriction to limit the recipient's right to reply to an email. 
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5. StealthMail tab 
After Add-in installation, the StealthMail tab will appear on the Ribbon (Fig. 5-1).  

 
Figure 5-1 StealthMail tab  

Table 5-1. Commands of the StealthMail bar 

Icon  Command  Description 

 
Accounts  Opens a sidebar to manage the accounts. 

  Settings  Contains service settings. 

 
Send Feedback  Opens a web page with a feedback form. 

 
Technical Support  Opens service support portal. 

 
Help Videos  Directs to the videos on how to use the service. 

  About StealthMail 
Shows the current version of the service and hyperlinks both to 
the official site and the feedback web pages. 

 

5.1 Accounts 
The Accounts command is used to add a 
new account and view detailed 
information about the current one. The 
command is presented as a side sidebar 
Accounts in Outlook (Fig. 5.1-1). 

To evoke sidebar, click the StealthMail tab, 
point to the Management group, and then 

choose Accounts . 

 
Figure 5.1-1 Accounts sidebar 
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To view detailed information about your 

account, click the Details  button. 

  

In the Account details sidebar, you can 
find information about: 

▢ Account name 

▢ Account type 

▢ Company name 

▢ Connection state 

 

By clicking on the corresponding button 
you can: 

▢ Remove account from Add-In 

▢ Change account password 

▢ Disconnect 

 
Figure 5.1-2 Account details sidebar 

 

5.1.1 Authorizing 

To create, send, and receive secure emails, authorize in your StealthMail account.  

To authorize: 

1. On the StealthMail tab, in the 
Management group, click 
Accounts. 

2. In the opened Accounts sidebar, 
click Authorize (Fig. 5.1.1-1). 

 
Figure 5.1.1-1 Authorization from the Accounts sidebar 
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You can also authorize from the Details 
sidebar:  

1. In the Accounts sidebar, click the 
Details button. 

2. In the Account details, in the State 
section, click the Authorize button 
(Fig. 5.1.1-2). 

 
Figure 5.1.1-2 Authorization in the Account details 

 

5.1.2 Password restoring 

If you forgot your password while 
authorizing, you can restore it: 

1. On the StealthMail bar, in the 
Management group, click 
Accounts. 

2. Click Restore password  
(Fig. 5.1.2-1). An SMS with a 
verification code will be sent to your
phone. 

 

 

 
Figure 5.1.2-1 Password restore 

 

 

User Guide | StealthMail Add-in for Outlook 28  



 

 

3. Enter the six-digit code from the 
SMS in the corresponding field 
(Fig.5.1.2-2).  

4. Enter a new password, repeat the 
password, and then click the  
Set password button. 

 

Figure 5.1.2-2 Setting a new password 

 

5.1.3 Password changing 

In StealthMail Add-in you can change your 
current password to a new one: 

1. In the Accounts sidebar, click 
Details.  

2. In the Protection section, click 
Change password (Fig. 5.1.3-1). 

 

 
Figure 5.1.3-1 Current password changing 
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3. In the Change password window, in 
the Old Password field, enter your 
current password. 

Set a new password, confirm the 
new password, and then click Set 
Password (Fig. 5.1.3-2). 

 
Figure 5.1.3-2 Setting a new password 

 

5.1.4 Signing out 
If you want to log out of your account, go 
to the Accounts sidebar, and click the 
Disconnect button (Fig. 5.1.4-1). 

 
Figure 5.1.4-1 Signing out 

 

 

User Guide | StealthMail Add-in for Outlook 30  



 

You can also disconnect from the Account 
details window:  

1. In the Accounts sidebar, click the 
Details. 

2. In the Account details window, in 
the State section, click Disconnect 
(Fig. 5.1.4-2). 

 

Figure 5.1.4-2 Signing out from Account details 

 

5.1.5 Removing 

StealthMail Add-in application provides 
the possibility to delete an account from 
the Add-In. 

To delete an account: 

1. On the StealthMail tab, in the 
Management group, click 

Accounts . 

2. On the Accounts sidebar, click 
Details. 

3. Choose the account you want to 
delete, and click the  
Remove from Add-in button. 

4. In the dialog box, click Yes to 
confirm you want to delete your 
account (Fig. 5.1.5-2).   

Figure 5.1.5-1 Account removing 
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 Figure 5.1.5-2 Account removing dialog box 

 

5.2 Settings 
This chapter provides information about 
the StealthMail service settings. 

The Settings menu (Fig. 5.2) contains 
options that allow you to manage the 
StealthMail service. The selected settings 
apply to all accounts added to StealthMail 
Add-in. You can change the service 
parameters regardless of what account 
you are connected to. 

There are two ways to access the Settings 
menu: 

1. Go to the StealthMail tab, 
Management group, and click 

Settings . 
2. For quick access on the Outlook 

ribbon, go to the Home tab, 
StealthMail group, and click 

Settings . 

 
Figure 5.2 Settings menu 
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5.2.1 Secure email contents 

StealthMail will automatically decrypt the contents of secure emails right after you 
authorize into the service. This option is enabled by default. Click to clear the 
Decrypt instantly check box, if you do not want to display the content of secure 
email after authorizing (Fig. 5.2.1). 

 
 Figure 5.2.1 Secure email decryption 

In this case, to decrypt the content, click the Show Content button in the email 
preview window. 

 

5.2.2 Connection 

This option automatically disables all 
connections to the StealthMail service 
after the computer is left idling for a set 
time.  

From the drop-down list, select the time 
when the connection will be disabled 
automatically (Fig 5.2.2): 

▢ 5 minutes 

▢ 30 minutes 

▢ 1 hour 

▢ 4 hours 

 
Figure 5.2.2 Connection 

 

5.2.3 Security options for new emails 

There are two security options which can be applied to new emails by default within 
StealthMail Add-in:  

1. Secure. In this mode StealthMail encrypts and transfers emails using 
cryptographic algorithms.  

2. Unprotected. In this mode emails are not encrypted (Fig.5.2.3). 
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Figure 5.2.3 Security options 

 

5.2.4 Automatic download restrictions  

This option allows you to set a download 
limit (in megabytes, MB) for email 
content and attachments (Fig. 5.2.4). 
Select preferred option for automatic 
download:  

▢ Always download 

▢ 20 Mb 

▢ 5 Mb 

▢ Manual download 

 
Figure 5.2.4 Automatic download limit 

 

5.2.5 Language 

To change the add-in language: 

1. Go to the StealthMail tab, 
Management group, and click 

Settings . 
2. In the StealthMail Add-in sidebar, 

in the Language section, from the 
drop-down list select the language 
you want to use (Fig. 5.2.5).  

 
Figure 5.2.5 Language 
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5.3 Send feedback 
This command opens the web page with the Feedback Form. By filling out the form, 
you can share your personal user experience with the developers: 

- share ideas and suggestions on how to improve StealthMail Add-in; 

- ask questions about StealthMail Add-in; 

- describe the problems you experienced while working with StealthMail Add-in; 

- provide feedback on StealthMail Add-in. 

 

To send feedback about the service, perform the following steps: 

1. On the StealthMail tab, in the Support group, click Send Feedback . 

2. Select one of the two subjects for the message in the new window. 

3. Write your message in the text field.  

4. If you want to attach files to your message, click Select. In the dialog box, 
select the required files, and then click Open. 

5. Select the I'm not a robot check box. 

6. To complete filling out the form and send your feedback, click Send Message. 

 

5.4 Technical support 

The command opens the StealthMail Service Support Portal, where you can describe 
the problems you have encountered while working with StealthMail Add-in. 

 

5.5 Help videos 
The Help Videos command opens the Video Help web page.  

To view video instructions go to the StealthMail tab, point to the Support group, 

and click Help Videos command . 
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The web page contains short instructional videos about the main functions and 
settings of the service: 

▢ Installation of StealthMail Add-in 

▢ Adding StealthMail account from Email preview 

▢ Adding StealthMail account from side pane 

▢ Authorizing from side pane 

▢ Sending encrypted Email 

▢ Previewing encrypted Email 

▢ Replying encrypted Email 

▢ Sending encrypted Email to an external user 

▢ Enabling StealthMail Add-in in Outlook options 

▢ Uninstall of StealthMail Add-in 

 

5.5 About StealthMail 
About StealthMail command opens a 
sidebar, which displays the current 
version of StealthMail Add-in, a brief 
description of the service, links to the 
company's website page with the 
Feedback Form.  

To view the current version of the Add-in, 
go to the StealthMail tab, in the Support 

group, and click About StealthMail . 

 
Figure 5.5 Service version 
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6. Uninstalling 
To remove StealthMail Add-in from your computer, perform the following steps: 

1. Go to the Start menu. Open the Control Panel. Go to the Programs 
category, then select Uninstall a Program. 

2. In the list of programs, find and select StealthMail Add-in.  

3. Click the Uninstall button in the Uninstall programs window of the 
command bar. 

4. To start the process of uninstalling the application, click the Yes button in 
the opened security User Account Control window (Fig. 6-1). 

 
Figure 6-1 Windows Security pop-up 

5. To confirm the removal of the service, click the Yes button (Fig. 6-2). 

 

Figure 6-2 StealthMail Add-in removal 

6. To continue removing the service, click the Uninstall button. To clear the 
service data records from your computer's hard drive, select the  
Delete cache check box in the window that opens, and then click the 
Uninstall button (Fig. 6-3). 
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Figure 6-3 StealthMail Add-in removal 

7. Wait for the service to be removed. 

8. To complete the removal, click the ОK button (Fig. 6-4). 

 
Figure 6-4 StealthMail Add-In removal 

 

7. Troubleshooting 
This chapter provides recommendations on how to correct errors that may occur 
while working with the service. 

 

User Guide | StealthMail Add-in for Outlook 38  



 

7.1 Invalid verification code 
Problem: After you have entered the verification code from the SMS, the service 
displays the Invalid verification code message (Fig. 7.1). This message may appear, 
because the time allotted for entering a code has run out. 

  
Figure 7.1 Verification code entry 

Possible solution: Click the Start over button to start the authorization again.  

 

7.2 Invalid password 
Problem: After you have entered the password in the Accounts sidebar, the service 
displays the Invalid password message (Fig. 7.2).  

 

Figure 7.2 Invalid password entry 
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Possible Solution:  

1. Make sure the password you’re entering is the exact one you used when were 
adding the account.  

2. Make sure that Caps Lock is turned off and try again.  

If you are unable to resolve the issue, press Restore password and follow the 
further instructions. 

 

7.3 Inactive StealthMail tab 
In some cases, there is no possibility to automatically activate the Add-in.  

If the StealthMail tab does not appear on the Outlook Ribbon after the service has 
been installed, you need to enable Add-in manually.  

To activate the StealthMail Add-In tab: 

1. In Outlook, open the File Menu, and click the Settings menu. 
The Settings window will open. 

2. In the Settings, in the Add-Ins section, click the Go button. 
The COM Add-ins window will open. 

3. In the Add-ins available list, scroll down the list, select StealthMail Add-In, 
and then click OK (Fig. 7.3-1). 

 
Figure 7.3 Enabling StealthMail Add-in in Outlook settings 
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